
Page 1 of 94  Rev 12/19 
 

HealthSpace Office User’s Manual 
Table of Contents 

 

HealthSpace Office User’s Manual ................................................................................................. 1 

Table of Contents ............................................................................................................................ 1 

Introduction .................................................................................................................................... 4 

Finding Help .................................................................................................................................... 4 

Local Help .................................................................................................................................... 4 

Support Forum ............................................................................................................................ 4 

Help Desk .................................................................................................................................... 6 

Installing Software ...................................................................................................................... 7 

Passwords ................................................................................................................................... 7 

Local Databases........................................................................................................................... 9 

Server Databases ........................................................................................................................ 9 

Sharing Your Data ....................................................................................................................... 9 

Replication Cycle ....................................................................................................................... 10 

Getting Started .............................................................................................................................. 12 

Opening your database ............................................................................................................. 12 

Toolbar and Smarticons ............................................................................................................ 12 

Status Bar .................................................................................................................................. 13 

Views ......................................................................................................................................... 13 

Database View .......................................................................................................................... 14 

Manipulating Views .................................................................................................................. 15 

Fields on Forms ......................................................................................................................... 17 

Configurable Settings ................................................................................................................ 20 

Printing ...................................................................................................................................... 20 

Searching Views ............................................................................................................................ 22 

Advanced Searching .................................................................................................................. 22 

Physical Location ........................................................................................................................... 27 

Database Structure ................................................................................................................... 27 

Physical Location Document ..................................................................................................... 27 

Licensing ........................................................................................................................................ 35 

Creating a New Food Facility .................................................................................................... 35 



Page 2 of 94  Rev 12/19 
 

Creating a License and Applying Payment to a New Facility .................................................... 39 

Other Billing Actions ................................................................................................................. 42 

Change of Ownership ................................................................................................................ 43 

Other Tasks Associated with a Facility ...................................................................................... 45 

Create and New Buttons ........................................................................................................... 46 

Inspection Schedules .................................................................................................................... 47 

Finding Scheduled Inspections.................................................................................................. 47 

The Complaints Module ................................................................................................................ 52 

Accessing Complaint Forms ...................................................................................................... 52 

Starting a Complaint Associated with a Facility ........................................................................ 52 

Starting a Complaint NOT Associated with a Facility or Physical Location ............................... 53 

Starting a Complaint Associated with a Facility ........................................................................ 56 

Special Events/Temporary Restaurant Module ............................................................................ 58 

Accessing Special Events/Temporary Restaurants ................................................................... 58 

Special Events ........................................................................................................................... 58 

Adding Vendors ......................................................................................................................... 60 

Permitting the Temporary Vendor ........................................................................................... 62 

Cloning an Event ....................................................................................................................... 65 

Removing/Dissociating an Event and Vendor........................................................................... 66 

Operational Review................................................................................................................... 67 

Billing Configuration...................................................................................................................... 68 

Billing Settings ........................................................................................................................... 68 

Editing Fee Configuration Documents ...................................................................................... 69 

Miscellaneous ............................................................................................................................... 73 

Replication and Save Conflicts .................................................................................................. 73 

Pro-rating Licenses .................................................................................................................... 74 

Generating next year’s licenses for facilities that open after your renewals/billing run ......... 77 

Choosing Between Second/Third/Final Renewals or Invoices ................................................. 77 

Creating Second/Third/Final Notices from the Totals Owing View .......................................... 79 

Creating Invoices from the Totals Owing View ......................................................................... 82 

Exempt Status Facilities ............................................................................................................ 84 

NSF Checks ................................................................................................................................ 85 

Overpayments ........................................................................................................................... 85 



Page 3 of 94  Rev 12/19 
 

Batch License Payments ............................................................................................................ 87 

Ready to Print View................................................................................................................... 88 

Removing late fees from a license ............................................................................................ 89 

Emailing Inspections ................................................................................................................. 91 

Best places to enter information in the system ....................................................................... 93 



Page 4 of 94  Rev 12/19 
 

Introduction 
 
In this manual you will find information that will help you navigate through Notes and 
EnviroIntel; first looking over the application to understand the look and feel, and then 

more specifically looking at the forms and processes you will use throughout the system. 
 

Use the Oregon EHS Testing Database to practice anything you want to try in 
HealthSpace—you can’t break it!  There is a lot of unusual/incorrect data in there from 
everyone practicing, so disregard any oddities you see. 

 
The EnviroIntel databases and user interfaces are built in the IBM Notes Environment, 

allowing for the use of the database from remote locations whether connected to the 
internet or without that connection. The Notes platform also allows HealthSpace 
developers to make changes to the system in a way that will not overtax IT departments 

or cause interruption to the end users daily experience. The program can also be used 
seamlessly in any Windows environment and on any PC, whether desk-top, lap-top or 

tablet. 

Finding Help 
 
For assistance with the HealthSpace software, please call 866-860-4224 for customer 
support or Erica Van Ess with the Oregon Health Authority (Oregon’s Primary 

Administrative Contact - PAC) at erica.vaness@state.or.us or 971-673-0446.   
 

Local Help 
Website:  

Additional documents and videos for new users are available on the FPLHS Regulator’s 
Page at www.healthoregon.org/regulators on the HealthSpace Software page. 

 
Co-workers:  
Many of your co-workers will have achieved a degree of efficiency in various portions of 

the program and may be able to assist you. 
 

Primary Administrative Contact (Erica at OHA):  
The PAC provides primary, database or district help by answering questions, supplying 
support and doing basic troubleshooting. Erica will also put in the requests for a userid 

and password for any new staff in your jurisdiction. 

 

Support Forum 
The Support Forum database contains a history of all the approved changes requested by 
your PAC and the responses by both department staff and HealthSpace staff, so reviewing 

Forum items may answer your questions. This is also the area in which will make 
suggestions for changes, report bugs, and suggest new tools to improve or ease the way 
you work. Feel free to comment or add responses to suggestions made by others in the 

Design Forum. 

 

mailto:erica.vaness@state.or.us
http://www.healthoregon.org/regulators
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Posting in the Forum: 
Double click on the icon from your Replication and Sync screen: 

 
 

Click on New Problem: 

 
 

Type out a description in the Subject, Select a Posting Type=Problem or Bug 

Report, and Category=Core-Administration (the general catch all): 

 
Add a screen shot and more details in the description of the problem (exactly 

what did you click on to product the error, etc.).  You can drag and drop either a 
pdf or jpeg file into the white space, attach them using File>Attach from the top 

menu, or use the paperclip icon in the top tool bar. 

 
The answer to your question will also be shown in the forum, so you will need to 

check back and look for your question under the Reviewed or Resolved twisties:   



Page 6 of 94  Rev 12/19 
 

 
 
 
Following a Discussion 

Select the All Documents view to see a chronological listing of main topics for discussion 
and their responses. 

Select the By Author view to see what individual members of the discussion group have 
said. 
Select the By Category view to browse the group's discussions categorized by main topics. 

 

To Respond to a Discussion: 
1. If you want to respond to a main topic, first highlight the main topic document and 

then select Create/Response. If you want to respond to the message in a response 
document, highlight the appropriate response document and then select 
Create/Response to Response.  

2. Complete the response form. 
3. When you are done, press ESC and answer “Yes” to save your new document. 

 
Help Desk 
Help Desk Support  (Available Monday through Friday from 7am through 6pm) 
We try to respond to all help requests within 4 hours of receipt during work hours. 
 
E-mail:  
If you are having difficulties that cannot be resolved by any of the above methods, please 
e-mail a detailed description of the problem to: support@healthspace.ca  
 
Telephone:  Should you not be able to contact us through e-mail, make a detailed 

description of your problem and call this toll free number: (866) 860-4224 
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When placing a call to the HealthSpace Help Desk, it is important that you have access to 
the computer and portion of the program you are having difficulty with, so that support 

personnel can help directly. 
 

Installing Software 
Go to the FPLHS Regulator’s Page:  www.healthoregon.org/regulators to download the 

install instructions. 
 

Passwords 
Passwords prevent others from using your ID file to access the databases. After a 

password is set, Notes prompts you to enter it each time you open the program.  For 
security reasons, when you enter your password in the text box, it appears as a series of 

“X”s. 
 
Note:  You will always see the same keychain on the login screen when your password is 

entered correctly.  For example, I will always see the same orange and blue ball after I 
finish typing in my password if I got it right: 

 

 
 
For security reasons, you should change your password from the one initially assigned to 

you. 
• It should contain at least eight characters. 

• At least 1 of these should be a non-alphabetic character. 
• Your password should not be a single English word or common combination of 

them. 

 
Notes may not accept your first password. When this happens, type a new password that 

is either longer, contains more varied kinds of characters, or contains fewer words and 
names. 

 
 
 

 

 
 

 
 
When you have changed your password, memorize it as there is no record of what the 

new password is. If you forget your password, talk to your PAC who will request a new 
password for you.  

Notice: 

Passwords are case-sensitive. 
For example, Notes interprets "MickeyMouse" and "mickeymouse" as 

different passwords.  

 

http://www.healthoregon.org/regulators
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How to create a new password: 
1. From your Replication Screen, click on File>Change Password: 

 
 
2. Enter your current password first and you will see the Change Password box: 

. 
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3. Type your new password twice following the instructions under Tips.  A message will 
pop up stating the change was successful. 

4. Click on OK. 
 

Local Databases 
Databases that are used only by you and reside on your computer are called local 

databases. The local replica on your machine is kept up to date by the means of 
replication. In most scenarios the user will want to work on their local database. 

 
Benefits of using local databases are: 
Processes generally move more quickly working locally, and if, for some reason, the 

servers are down, those working only on servers will have to wait until the server is back 
up and running. 

 

Server Databases 
The databases are also stored on servers and are called shared databases.  They are 
accessible by all users of the system. 

The server's names that you may become familiar with are: 

 
  

Dogwood Eagle 

 
Sharing Your Data 
Replication is the process of sharing data between computers and servers.  Each of the 
servers has your databases stored on them. They “talk to” or replicate their information 
with the databases on your machine. 
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Replication Cycle 
In the same way that you are replicating, all of your co-workers are sending their data to 

the servers and receiving changes as well to keep data up-to-date through a complete 
replication cycle.  The system replicates every 10 minutes when you are in the office 

and/or if you are connected wirelessly to a network. 

 
 
The Replicator Page as your Start up screen 

The Replicator page lets you manage replication of all your local databases.  
This page has been set up as the starting point when opening the Notes application. This 
allows you to see the initial replication of the data the first time you open for the day to 

be sure a full replication cycle of your Live data has occurred before opening the 
database.   

 
Be sure to let it finish replicating completely before opening your database each 

day. 
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Understanding the replicator page: 

 
1. The default should be the Replication screen, or you can click on the Replication 

Bookmark:  in the left hand icon menu. 
 

 
 
2. You can determine the order in which databases replicate by dragging the entries into 

a different sequence so that they replicate in a different order. 
 

3. For a database to replicate, the box on the left side of each entry must be checked as 
Enabled:  

      
4. The arrows in the “Scope” column indicate data that is being sent and/or received from 

the servers: 

     
 
5. The Summary shows whether replication was successful or failed, and the number of 

documents sent and received. 
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Getting Started 
 

Opening your database 
 
After it has finished replicating, click on your Live database to view all your data: 

 
 

 
Toolbar and Smarticons 
The Toolbar in the views contain drop-down menus like File, Edit, and Create. It is also 
made up of Smarticons. 

 
 
Smarticon 
Each Smarticon performs an action when clicked (for example: italicizing selected text). 

For many tasks, it's faster to click a Smarticon than to use drop-down menus. 
When working in your database, you can find out what a Smarticon does by hovering the 

mouse pointer over it without clicking. A tool tip will pop up and tell you the name of the 
icon. 
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Expand and Collapse Buttons 
These plus and minus Smarticons help you expand and collapse categories, document 

"families" folders or views.  You will use these icons frequently to look at more or less 
data on the screens. 

 
 

 
Status Bar 
The status bar appears at the bottom of the Notes main window. As you work in Notes, 

system messages and features appear in the status bar.  
 
The status bar is context-sensitive, meaning the messages and features that appear in the 

status bar depend on the task you are performing and where you are in Notes. 

 
 
An important item to check is to be sure you are Online so that the system will replicate 
routinely with the servers. 

 

 
Views 
To understand what a view is, it is first important to know that a database is a 
collection of documents, folders, and views. In general, it is any organized 

collection of information. A View is a list of documents within this database. 
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Database View 
In EHS, databases are structured to show documents as Parent (Physical Location) or 
Child (Facility) documents.  

 
In this main menu view, you see main documents listed which are called the 
Parent/Physical Location Documents: 

 

How to view child documents: 
 
Documents shown by expanding a twistie are called child documents.  They are created 
from, and remain associated with, the parent document. 

 
A child document, as shown in this view may also have “twisties,” indicating that it too 

has documents created from it (licenses, renewals, inspections, etc.): 

 

Child Documents > 

The green arrow in front of each item (called a twistie) signifies that there are 
documents listed underneath, called Child/Facility documents 

Child Documents > 
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Database Structure 
Becoming familiar with the structure of the database will help you when searching for 

specific documents. 
 

All documentation stems or "hangs" from the Physical Location document.  Double clicking 
on a document in the view will open it.  Clicking on the twistie will show all documents 
associated with that location. 

 
Each building will have its own Physical Location document.  The facilities inside this 

Physical Location will have their own Facility documents.  A Facility may have Child 
Documents, such as inspections, licenses or complaints. 
 

 
Parent/Physical Location  

      Facility Documents  
   
                  Child Documents 

 
 

 
 

 
 
Manipulating Views 
 
Sortable Columns 

The views can be manipulated in ways that will help you make more efficient use of 
columns. 

If a column title has a ^ or v next to it, it is a sortable column. 

 
 
On default the view is categorized by the Physical Location, Common Name.  To change 

this, just click on the column heading that you would like to sort by.  Remember the ‘type 
to search’ function won’t work if you are sorted by a column other than Common Name. 
 

Arrange Columns 
Another feature of the views in your database is that you can use the “drag and drop” 

feature to move columns around if you want to see columns in a different order. 
 
Simply click and hold the column heading, move your mouse until your column is in the 

desired location, and release the mouse button. 
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Customizing Views 

By customizing views, you can hide columns on your local database. This can help when 
dealing with very large views, or for creating reports where only specific information is 

required. 
 

How to customize the view: 

1. Click on "View", "Customize this View...". 
This brings up a window to choose which columns to de-select in the view. 

 
2. Choose “OK” when you have finished customization. 
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How to restore the defaults: 
1. To restore the defaults, go back to “View”, “Customize this View”. 
2. Click on the defaults button. 

 
As you can see from the dialogue box for customizing the view, there are more options to 
choose from. 

3. Try experimenting in Oregon EHS Testing database to see what different views can do 
for you. 

 

Fields on Forms 
Think of a document within an EnviroIntel database as a record, but the document is more 
sophisticated than a typical database record, containing rich text, pictures, objects, and 

many other types of information. 
Information is entered into "Fields" of various types. Once saved and closed this document 
will appear in one or more views.  
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Attachments 
 

 
 

Some reminders when adding attachments and importing images: 

 

✔ Attach only black and white pdf or .jpg files to keep the system 
from getting bloated 
 

✔ Use attachments where you can rather than importing images. 
Attached documents do not open the image when opening the form,  
whereas an imported image must load each time the form opens causing  

the system to slow down.  
 

✔ Save the files in a JPEG or GIF format before attaching. 
BMP images are much larger and will cause the database to become bloated. 

 

✔ If you are not sure of the size of your document,  
check the properties of the image. 
If it is larger than a megabyte you should think about re scanning  
the document before attaching. 
 
The larger the attachments and images in your system,  
the longer the documents take to open,  
and the slower your system will run. 

 
 
 

How to add Attachments: 
 

1. Click in the Field where you would like to attach the file.  Frequently this is a 
‘comments’ field 

 

The formatting buttons will become active. 

 
 
Click on the attachment button: 
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2. This brings up the create attachment box:  

 
 

Browse until you find the file you would like to attach. 
  

3. After selecting the file you want to attach, click on the “Create” button and it will show 
the file icon in the field. 

 

Date Ranges 
 

To specify a date on a form: 
1. Click the date icon to open the date picker. 

 
2. To move back or forward one month, click on the arrows in the top corners of the date 

picker. 
3. Click on the day you want when the month is correct. 

When typing the date into the field, use any format and the program will convert it.  
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Configurable Settings 
The Primary Administrative Contact (PAC) for your Area manages these configurable 
settings.  If you have questions about the configuration of the program or settings that do 

not meet your requirements, contact your PAC who can adjust configurable settings. 

 
Printing 
You will have to experiment with the printer settings that give you the best results with 
regards to to margins for your inspection reports, renewals and licenses.  For most 
counties, setting your margins in Page Setup to 0, .5, .5 and 0 works best: 
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 How to print views or documents: 
 

1. Select the entries that you want to print and choose Print from the File menu. 

 
 
When the dialogue box comes up you have the option to print the documents that you 
have selected or to print the selected view. When you choose to print the view, the 

column headings also print. Documents can be printed from the file menu from the view 
or with the document open. 
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Searching Views 
To find a record, just start typing anywhere in the main screen and it will pop 
the record to the top (the ‘starts with’ search). 
 

Advanced Searching 
There are three types of searches that enable you to find information you specify, 
including text, documents, databases, people's names, and much more. 
The search features are: 

• Starts With Search (most commonly used) 
• Find/Replace 

• Full-text Search 
 
“Starts with” Search 

When looking at a view, you can quickly find a document or category.  
 

To do a "Starts with" search: 
 
1. Click anywhere inside the view. 

2. Type part of the word you want to search for. For example: “r”, or “raj”. 

 
 
The view will jump to the first entry which starts with “R”.  
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Find/Replace 

You can quickly and easily search for a word in a view or document using the Find/Replace 

button which looks like a binocular. 

 

 

 
Notice: 
 
Using the Find/Replace button in a view,  

finds the text in the view only,  

but does not search the document itself. 
 
You can also use  <Ctrl> + <F> when in a document  
or view to use this search. 

 

 

To do a "Find/Replace" search: 

1. Click on the Find/Replace button. 

2. Enter the text you want to find in the dialog box that appears. 
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3. Click “Find Next” or just hit <Enter>. This will find the first occasion of the word in the 
document or in a view. 

 

4. Continue to click next or enter to see each time the word is used in the document.  

 

Full-Text Search 

When you are working in a view, you can find text in a document with the Full-text 
search. It appears as a magnifying glass. 

Using this type of search on an indexed database gives you a powerful tool for searching 

through your entire database for precise information that may appear in a view or in a 
document. 

For example:  
Search for “River”. 
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The search found 32 documents in the current view containing the word "River". 

 

Operators 

On an indexed database, certain words called operators, in the search criteria, act as 

instructions. 

AND, OR, NOT, used in combination with the words you are searching for will give you 

more defined choices. 

OR Operator 

Search for criteria a or b in the database. 

For example:  

“John OR Mike” - the search will find all documents that contain the name John or Mike.  
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AND Operator 

Search for documents, which contain criteria a and b in the database. 

For example: 

“Playground AND John” - the search will find all documents which contain the word 

playground and John. 

NOT Operator 

Search for documents, which contain criteria “a” but not “b.” 

For example: 

“inspection NOT food” - the search will find all inspection documents except food 

inspections. 
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Physical Location 
 

During this chapter you will learn about the Structure of the EnviroIntel EHS 
database and the importance of the Physical Location Document. 

 

Database Structure 
The Main view shows the relationship between the documents. The top level document is 
called a “Parent” document. When a “twistie’ is expanded you can see the documents one 

level below the “Parent”. Each one is a “Child” document to the parent. 
 

 
For example:  

The Best Western Grand Manor Inn above is the Physical Location at 971 Kruse Way.  
From it hangs child documents, such as food, hotel, pool and spa facilities.  

Under these child/facility level twisties are more child documents such as Inspections, 
Renewals and Permits/Licenses. 
 

All documents that are associated with its Parent document are categorized together, in a 
similar way to a filing system with all documentation "hanging" from the Physical Location 

document. 
 

Physical Location Document  
 

One way we can describe the Physical Location is that it is the building that houses 
various types of establishments. For instance, before we can open a hotel facility we need 
to have a building to put it into. 
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Once a Physical Location document is completed, all associated facilities (for hotel, pool, 
spa and/or food service) are created from this document.  

 
 

Finding the Physical Location associated with a facility 
 
If you know the address of the facility and location, name of the Physical Location use the 

“Starts with Search” to find the street address to see if it already exists in the database. 
 
1. To do this, first sort on the building number or street name to sort the view.  Scroll 

through the list to see if you have any addresses in the database that match the 
address of the facility that you need to enter into the system. 

 
If there is a matching address, you do not need to enter a new Physical Location 

and you can skip to Creating a New Facility 
 
2. If there isn't an address match, you will need to create a new Physical Location. 

 
 

How to create a new Physical Location: 
1. From the Main View click on the “New“ button, then choose “Physical Location”: 

 
 

A new Physical Location form will open. 
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When the Physical Location Form opens, you can see that the form breaks up into tables, 
categorizing the information. 

 
The other thing you will notice is that on the form there are some fields that have red 

arrows next to them that must have a value entered. These are called mandatory fields:  

 
If you are to save the document without the required fields filled in, you will get a prompt 
to enter a value into the field: 

 
 
Fields with orange arrows: 

 
Indicate the information is important though not required. 
 

Physical Location Tables 
Let's take a brief look at each table on the Physical Location form. 

The tables are as follows: 
• Identification 
• Legal Description 

• Global Position 
• Licensee 

• Contact Information for Physical Information 
 
Identification 

The first table is the Identification Table.  
It contains Information used for identifying the Location.  
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Tips about “The Common Name” 
Consistency with naming your Physical Locations is important for future 

searching and organization of data. 
 

Here are some guidelines that may help you to determine the Common Name of your 
Physical Location: 

 

 
 
      Guidelines for the Common Name: 
 
 

✔ If the building has a name like the “Sterling Building” or the “Rest Easy Hotel” use that name. 

✔ Use the establishment name if it stands alone in its own building. 

✔ If the building has more than one facility in it, use the name of the most prominent facility. 

✔ Give the Physical Location the name of a store or gas station if the facility is run from inside the 
establishment. 

✔ If there is no name for the facility, use the street address. 

✔ If there are none of the above, such as in the case of a logging camp, use a name that would 
indicate the location. 

✔ A close intersection, name of the field, or even a global position.  

✔ Use Title Case for Physical Location and Facility Names. Example: The Big Mall, The Donut 
Factory, Rainbow Kid's Daycare... 
 
Whatever you choose, be sure that you determine the format and use this consistently. 

 
 
 

 
 

Depending on the size of your organization, there will be many people who search for 
locations in the database.  
 

Naming conventions that everyone understands will save time for all! 
 

 
Legal Description 
Captures information with regard to the property in this table.  This is not a required field 

in Oregon and can be left blank. 
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Global Position 
GPS locations can be entered on the Global Position table.  This is not a required field in 

Oregon and can be left blank.   
 

 

 
 

However, if you want to enter this information, you can use Google Maps to help you: 
1. Open Google Maps on a web browser (maps.google.com) 

 

2. Search the address of the facility: 
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3. Right click the pin (it’s usually red): 

 
 

4. Select “What’s here?”.  At the bottom of the screen are the coordinates to where 

the pin is.  If the pin is located incorrectly, you can right click anywhere on the map 
and select “What’s here?” for that exact location. 
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Owner Information Table 
For the Physical Location form we are interested in capturing information about the Owner 

of the building.  This may not be the same as the Licensee of the establishment inside, so 
be sure that you are looking for the correct name. 

 
Details are entered once on a Licensee document in the system.  This info is then re-used 
for any other buildings or establishments in your database that has a common Licensee. 

 
Not only does this save time during data-entry, but also allows you to track all 

establishments operated by one business entity. 
 
Before you click on the “New” button to create another Owner form, check to see if the 

Owner exists in the database with the “Choose” button. 
 

How to choose an existing Licensee/Owner: 
 
1. Click on “Choose Existing”. 

This will bring up a list of all existing Licensee in the database, which you will want to 
search thoroughly first by name and then by address: 

 
The list can be sorted by name for a “Starts with” search on the Owner, or you can simply 
scroll through the list. 

 
2. Highlight the name and click on OK. 

 
3. If you find that the Licensee is not in the database, click on the “Cancel” button to take 

you back to the Physical Location form. 
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How to add a new Owner: 
1. Click on “New” button to enter the name of the Licensee. 

 
2. A box comes up for the Name, and when filled in another box asks if you would like to 

add further details. 

 
 
3. By Choosing “Yes” you are taken to the Owner Form where these details can be filled 

in. 

 
 

4. On the "Owner" form enter information about the (new) Owner of the Physical 
Location. 
 

5. Click on Done to save and close the Business form. 
 

Once the form is saved, you will notice that more buttons have been added to the Owner 
table: ”Change”, "View" "Open in Billing View”. 
 

• “View” opens the Business form so you can add more information if needed. 
• The “Open in Billing View” button opens the Main billing view to the name of the 

Owner.  
• This Owner will now be added to the existing list and can be reused by selecting 

“Choose”. 
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Licensing 
 
Once you have completed a new "Physical Location", you can then 
create a new Facility Form.  This section will look at the Food Facility 

and its tables. 
 

Creating a New Food Facility 
The Facility Form is the central form in the database. It holds information about the 

type of operation, its permit status, the owner name and contact information. It is 
the form from which inspection schedules are driven and billing is run.  

 
Your first step will be to search for an existing Physical Location. 
 

Open the Main Filing view and look for the Physical Location's name. If you can't 
find the name try to find the Physical Location with its address. Sort the view by 

address. With a “Starts with” search, look for the Physical Location's address. 
 
If you still can't find the specific Physical Location create a new document.  

 

How to add a new Food Facility: 
1. Open the Physical Location form. 

 
2. From the Physical Location form click on New and select the facility type from 

the list. 
 

 
 
As with the Physical Location document the Facility consists of various tables and 
fields. Some fields are marked with red arrows indicating that you must enter data 

in these fields before you can save the form. 
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Facility Information 
The Facility Information table captures information about the facility, including the 

name, assigned inspectors, and file active date. Some fields on this table are 
default fields and inherit their information from the Physical Location form. 

 
 
Facility Details 
In the second table, details about the facility type will be entered. For the Food 

facility, this will include the type, additional facilities, whether it is part of a chain or 
franchise, among other details.  Be sure to include number of seats, rooms or 

spaces. 

 
 
Operating Information (Permit/License Information) 

The Operating Information table is used to capture the status of the permit, its fee 
status and if the facility is open all year or is seasonal.  

 
The table defaults to the status of pending.  Change this to permitted unless 
the facility is still under construction. Enter the Application date, and when the 

facility moves from the Status Pending to Permitted, enter the permitted date 
(usually the date the inspector has signed off on the facility). The issue and 

expiration dates will populate automatically after the Licensee has paid the full 
permit fee.  
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Inspection Tables 

The Table “Last Inspection” will display information as entered on the last 
inspection or will be blank for new facilities.  This will auto-populate with the correct 

frequency once you have completed and saved this form. 
Licensee/Owner Table 
The Owner name defaults to the Licensee as entered on the Physical Location form. 

If the Licensee is different from that Licensee, choose New and follow the same 
process for creating a Licensee specific to this facility. 

 
 
Contact Information for Facility 
 

The Facility Location address information tab defaults to that entered on the 
Physical Location. 

 
 
The Mailing Address tab has 2 auto selections and you will want to select Copy 
Business Address: 

 
The Billing Address tab defaults to the Owner’s address. 
 

The Phone /Email tab needs to be completed information specific to the facility 
itself (it might be the same as the owner information but might be different). 

 
Comments 
Below the Contact information table, comments can be captured for the facility. 
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Creating a License and Applying Payment to a New Facility 
 
The licensing billing process for a new facility is a manual process. Go to the Billing 

part of the form and add a Billing Type based on the seats/spaces/rooms entered in 
the Facility Details: 

 
 
 

Now open all three twisties so you can see clearly what is happening: 

 
 



Page 40 of 94  Rev 12/19 
 

 
 

Use the Create Annual Fee button to set the License amount. 

If needed, an invoice or renewal document can now be generated for the fee using 

the Create Invoice button on the Billing table.  You can view the invoice by double 

clicking on it in this view: 

 

When payment for the license fee comes in, use the Post payment button on the 
Billing table to apply payment and automatically generate a license: 

 
 
The license can be opened and printed from this screen or it can be batch printed 
from the Billing>Ready to Print view. 

 
This completes the process for single facility billing. The facility is set up for the 

next year's automated renewal fee and invoice creation. You will notice that the 

various billing documents created during this process now appear in the filing view 

as child docs of the facility form or can be viewed on the billing table on the facility 

form: 
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Other Billing Actions 
Remove Payment button: If a payment was entered in error, or details were left 
off the payment, there is a button to remove the payment. If you do remove the 

payment you may be asked to enter a reason for the removal of the payment for 
reporting purposes. 
  

Remove Fee button: If a fee was created in error, or is incorrect amount, a button 
is available on the billing table to remove the fee. If a payment has already been 

applied to a fee, the fee will be locked down. You will need to remove the payment 
first and can then remove the fee. 
 

Adjusting Entries button: A payment entered incorrectly in the database does 
not need to be removed. An adjusting entry document can be created in the 

database to correct the payment, lessening or adding to the amount owing by the 
licensee.  This is commonly used for NSF payments. 
 

The system will treat an additional amount owing by the licensee as a fee and if the 
client owes a lesser amount than the fee indicates, the adjusting entry will be 

treated as a payment 
 
Print Receipt Button: To issue a receipt for payment, click on the Print receipt 

button. You will be asked to choose which payments you wish to print on the 
receipt. The document then appears on screen where you can print it.  

*Note: the receipt document is not a document that is saved to the system. 
 

Regenerate Permit Button: If a change is made to facility information and a new 
permit issued, or a permit needs to be re-printed for the Operator, make the 
necessary changes to the facility document and click on Re-generate permit. This 

will update the current year's permit allowing you to print with the most recent 
changes to the facility.  

 
This should not be used if a facility is closed and opened under another owner. In 
this scenario follow the Change of Ownership procedures below. 
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Change of Ownership 
 
Office: 

Double click to make the facility editable, then scroll down to Licensee/Owner and 
click on Change: 

 
 
You will get a message asking to close the facility, select OK: 

 
 

A new form pops up with an active date of today’s date, now is Pending (change to 
Permitted).  It will auto-populate everything from the previous facility except for 
the owner. 

 
If the facility name has changed, you will need to type in the new name: 
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Go to the Licensee/Owner section of the page and either make a New owner or 

Choose Existing to get the owner set up for the new facility.  Fill in all Owner info 
and hit Done. 
 

Make sure all information you have filled in for the new facility is correct and hit 
Done.  You will see that the old one is closed with a red minus symbol and now 

there is a new facility (Erica’s Gumbo Shack): 
 

 
 

Lastly, change the name of the parent document to reflect any name/address 
changes: 

 
 
Field – Instructions for inspectors who find a change of ownership 

(optional): 
If a facility is closing or changing owner, administration staff will manage the 
changing of the fields that need to be changed.  

As an Inspector, if it is a change of owner, or name change, continue to create the 
inspection under the existing facility. Then alert the clerical staff of the changes. 

Here is the process: 
1. On the facility document, click on Create at the top of the form and choose Note 

to File. 

2. Indicate with the note to file type field that this is a facility name change or 
owner change. 

3. Conduct inspection as normal under the old facility name/owner and let the 
operator know you will email them an updated report once the new ownership 
information is entered into the database. 

4. If a facility has closed, there is no need to create an inspection for this facility 
and you can just notify office staff of the closure. 
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Other Tasks Associated with a Facility 
 

Closing a facility (Admin Function) 
When a facility closes, two fields will be changed on the form. The Administrative 
Status on the Facility Information table should be moved to “Closed”, and in the 

Operating Information table, the status should be changed to “Out of Business”. 
Each of these fields have dates that correspond to them. 

 
Updating Licensee Information (Admin Function) 
Double click on the current owner name and choose View or Open in Business View 

and enter the correct information. 
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Create and New Buttons 
From the “Create” button, Correspondence, Notes to file, and Complaints can be 
created. 

 
Correspondence 
Letter templates (called print forms) can be set up in the database by a program 

administrator. Once the templates have been created, you will be able to choose to 
generate these letters from the facility document and have the system pull the 

values from the facility on to these forms.    
 
Examples of correspondence are:  Second Renewal Notices, Order of Closure, 

Dismissal of Closure, Temporary Restaurant Handout, Significant Rule Change 
handouts, etc. 

 
Note to file 
A Note to File is a document that can serve as a memo or "sticky note" in the 

system to serve as a reminder of a communication or action for that facility. It will 
appear as a child document underneath the related facility. 

Note to file should be used when a facility changes fee code or to document any 
other changes that it would be important for an inspector or office staff to be able 
to see easily without having to open up the facility. 

 
Complaint 

Complaints will be discussed in more detail under the Complaints Module section.  
Always use the Create>Complaint option to enter a complaint (not the 

New>Foodborne Illness option). 
 
New Inspection and Plan Review  

From the “New” button on a facility, various document types can be created. “New 
Inspections” are created for all facility types. And Plan Review is included for food 

service facilities.  Do not use the New>Foodborne Illness Complaint function, 
the Create>Complaint should be used instead. 
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Inspection Schedules 
 

Finding Scheduled Inspections 
 

1. Click on Main Menu from any view  
2. In this menu, look for the Calendar link. This will display the scheduled 

inspections for all inspectors in your county. 
3. If you are in the system as an inspector, click on Personal Calendar to view the 

inspections that are assigned to you. Double click on one of the entries in the 

calendar. This will take you to the facility document where you can choose 
"New" and "Inspection”. 

 
 
There are a variety of ways for the inspector to view their upcoming or overdue 
inspections. 

 
Routine Inspection dates are set in the system with the use of scheduling tools that 

the program administrator sets up. A Routine inspection will be scheduled based on 
the facility type for each facility. These dates are called Prescribed Inspection dates 
and display on the facility form in the Inspections table.  

 
Follow up inspection dates are automatically scheduled by the inspector from 

another Inspection based on the inspection result. This date is displayed on the 
facility as Re-inspection or Follow-up date. 
 

All Calendars and Personal Calendars 
From the All Programs menu, the Calendar and Personal calendar are views that 

display like calendars.  
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The Calendar 

In the Calendar, all scheduled Routine inspections and, follow-up inspections for all 
Inspectors are displayed on the date due.  

Double click the entry in the view to open the facility and choose to begin a Routine 
Inspection. Or if it is a follow-up that is due, double click the entry to open the 
originating inspection and click on the New Follow-up button. 

 
The Personal Calendar 

The Personal Calendar has the same behavior as the Calendar, however the only 
inspections that will be displayed are for the inspector who is logged into the 
application with their ID file. 

 
Example of a Personal Calendar View 

 
The Schedule View 
The schedule view, found just below the calendars, displays the same inspection 

due information but in a list format. The view also provides additional information 
about the facility, such as address and date of last inspection. 
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Additional Scheduling Views 
You can print schedules from Main Menu>All Programs>Inspections>Due.  For a 

printed schedule, you can open all the inspections, place a check 
 

Printing an Inspection Schedule List 

Exporting and Printing a Schedule: 
1. Go to your Ei Manager tab and select Classic Menu from the options at 

the top 
2. Then go to Inspections>Due and open the twistie by your name.  

3. Open the twistie for Upcoming or Overdue (or both depending on your 
needs) 

4. Use the plus sign in the top tool bar to open your entire facility list 
5. Select the child docs individually by putting a check mark out to the 

left of each facility, then use the menu item Actions>Export>View to 

Microsoft Excel.   

 
 

-OR- 
Go to Calendar>Personal Calendar: 

 
Then go to Formatting and select Summarize: 

 
Then go to File>Print>Calendar List and select a date range: 
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You may want to go back in time a month or two to ensure that you haven’t 
missed any inspections/reinspections. 
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The Complaints Module 

Accessing Complaint Forms 
There are 3 types of complaints: 

• Those associated with a Facility 
• Those associated with only an address or location not a Facility or Physical 

Location document. 
• Those associated with a Physical location. 

 

Starting a Complaint Associated with a Facility 
1. Open the Facility document. 
2. Click on Create and then click on Complaint. 

 
 

The complaint form opens. The Facility Information table captures information 
about the facility where the complaint incident occurred.  

 
 
3. Next enter the details of the complaint into the General Details table. The 

complaint type Date received, who received the complaint, and to whom is it 

being referred. 

 
 
4. If Complainant Information is provided, such as name and contact 

information, enter it into that table. 
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5. Complaint Details must be entered by the person who starts the complaint form 
into the Complainant Details and Actions table. 

 
6. The form can now be saved. 

The form at this point would show as pending in the view. (Information gathered, 
but no action on the complaint at this time.) There is a red icon ball in front of 

the Facility as well as an alert to staff to a pending or active complaint: 

 
 

7. To start the investigation, go to the Facility Document; the Complaints view in 
the All Programs menu or the Welcome screen and open the complaint 

document. 
 
When the person to whom the complaint was referred enters an investigation start 

date, the form moves to an active complaint status. The inspector can enter details 
and action taken in the available fields. If follow-up is required, a date can be 

entered, and the complaint form will show in the personal calendar embedded in 
the program. 
 

Time tracking can be entered on the form, and any images or attachments can be 
added to the form. 

 
8. Once a complaint has been completed, enter a value in the Date closed field. 

This will remove the red icon from the facility and will show as closed in the 

views. 
 

Starting a Complaint NOT Associated with a Facility or 
Physical Location 
The Complaint form can be accessed from the Welcome screen by clicking on the 

Complaints icon. 
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This opens the complaints view, where a new complaint can be created from the 
top of the view, and active complaints can be accessed and tracked. 

 
1. To start a new complaint not associated with a Facility or Physical Location, click 

on New Complaint: 

 
 

2. When the complaint form opens, the first table, Facility Information, captures 
information about the address where the complaint incident occurred. A facility 
name will not be entered (If the facility is known, use the facility document to 

start the complaint). 

 
 
3. Next enter the details of the complaint into the General Details table. The 

complaint type Date received, who received the complaint, and to whom is it 

being referred. 

 
 
4. If Complainant Information is provided, such as name and contact 

information, enter it into that table. 
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5. Complaint Details must be entered by the person who starts the complaint form 
into the Complainant Details and Actions table. 

 
6. The form can now be saved. 

 
The form at this point would show as pending in the complaints view (Information 

gathered, but no action on the complaint at this time.)  
 
This type of complaint can only be accessed through the complaints button or 

views. 
 

7. To start the investigation, go to the Complaints view in the All Programs menu 
or the Welcome screen and open the complaint document. 

 

When the person to whom the complaint was referred enters an investigation start 
date, the form moves to an active complaint status. The inspector can enter details 

and action taken in the available fields. If follow-up is required, a date can be 
entered, and the complaint form will show in the personal calendar embedded in 
the program. 

 
Time tracking can be entered on the form, and any images or attachments can be 

added to the form. 
 
In the complaints view any complaint not associated with a facility will have an icon 

with a question mark in it to indicate there is no facility. Click on the complaint to 
open it and assign a facility. 

 
 

8. Once a complaint has been completed, enter a value in the Date closed field. 
This will remove the red icon from the facility if applicable and will show as 

closed in the views. 
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Starting a Complaint Associated with a Facility 
1. Open the Physical Location document twistie so you can see the child/facility 

document.  Double click to open the facility document. 

 
2. Click on Create and then click on Complaint. 

 
 
When the complaint form opens, the first table, Facility Information, captures 

information about the Physical Location where the complaint incident occurred. The 
Physical Location name has been transferred to the form. (If the facility is known, 

use the facility document to start the complaint). 

 
 

3. Next enter the details of the complaint into the General Details table. The 
complaint type Date received, who received the complaint, and to whom is it 

being referred. 
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If Complainant Information is provided, such as name and contact information, 

enter it into that table. 

 
 
4. Complaint Details must be entered by the person who starts the complaint form 

into the Complainant Details and Actions table. 

 
 
5. The form can now be saved. 

The form at this point would show as pending in the complaints view. (Information 
gathered, but no action on the complaint at this time.) There is a red icon ball in 
front of the Facility view. 

 
6. To start the investigation, go to the Complaints view in the All Programs menu 

or the Welcome screen and open the complaint document. 
 
When the person to whom the complaint was referred enters an investigation start 

date, the form moves to an active complaint status. The inspector can enter details 
and action taken in the available fields. If follow-up is required, a date can be 

entered, and the complaint form will show in the personal calendar embedded in 
the program. 
 

Time tracking can be entered on the form, and any images or attachments can be 
added to the form. 

 
7. Once a complaint has been completed, enter a value in the Date closed field. 

This will remove the red icon from the facility if applicable and will show as 

closed in the views. 
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Special Events/Temporary Restaurant 
Module 

 

Accessing Special Events/Temporary Restaurants 
Temporary Vendor Facilities can be set up, permitted and inspected in HealthSpace 

through the Special Events module.  
 

Click on the icon found on the Welcome page to take you to this module. 

 

Special Events 
 
The Special Events module has its own set of views for both the events and vendors 

that participate in the events. It is a module that is separate from the Main Menu 
and your other licensed facilities. 

 
Temporary Food Vendors can be associated with a Special Event. 
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Begin by clicking on New Event from the Special Events view to open an Event 
document. 

 
 
Enter the Event Name, Event start and End dates, Address of event and other 
mandatory fields. 

 
  
Other information can also be added, such as Sponsor and Contact information for 

the event. This information can be re-used with the copy buttons if the information 
has been previously entered on other Events. 

 
Temporary Vendors can be added to the event if a Vendor has already been added 

to the database (if they haven’t been created yet, skip down to Temporary Vendors 
below).   
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Click on the "Add Facility" button in the Temporary Facilities table. A list of existing 

temporary facilities will come up in a window. Select all vendors that will be 
attending the event from this window, and click on OK. 

 
 

They will then appear in the Event's Temporary Facilities table. 

  

 
Adding Vendors 
To set up new vendors, click on the twistie next to Temporary Vendors in the left-

hand menu, select All Temporary Vendors and click on New Temporary Vendor. 
 

 
 
On the Temporary Facility, enter the Facility Name, and other mandatory fields.  

For the Type of Facility, choose either Benevolent Temporary or For Profit 
Temporary Restaurant.   
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Also, enter the operation day/times under Permit Conditions so those will show on 
the permit. 

 
Licensed restaurants will still need to be entered as a vendor, since they will have a 

separate license issued while acting as a temporary restaurant.

 
Connecting the Vendor to the Special Event can be done from the Vendor document 
as well as from the Event document. 
 

Once the mandatory fields are entered on the Vendor facility, choose the event that 
this vendor will be attending. A list of events will come up on the screen, select the 

event and click on "OK". 
 

 
This facility will now show in the Special Event window. 
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Permitting the Temporary Vendor 
 
The Temporary Vendor facility must have all mandatory fields filled in, the Billing 

type filled in, and have an owner associated with it. Once this information has been 
added to the form, the permitting is done from the billing table. 

 
 
Unlike the other modules, Fees and payments for Temporary Vendors permits 
are set up manually, done by clicking one button on the Billing Table "Issue 

Temporary Permit": 

 
 

Choose the event that this permit is for, by clicking on the event, and clicking on 
OK. 
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The Start and End Dates, as set up on the Event default to the Start and End Dates 
for the Temporary Vendor Permit. They are editable if those dates need to be 

edited.  
 

Enter the Fee amount into the Amount Field, enter a Fee Code if this is a value that 
needs to be tracked. OHA recommends using Single Event, Seasonal and 
Intermittent here for consistency.   

 
Enter the Payment Type, Payment Date and the Check details if applicable. 

 
Click on OK once this data is correctly entered.  
 
This action will Create the fee, Post the payment and generate the Temporary 

Vendor Permit by bringing it up on the screen to be printed. It can also be printed 
from the Vendor views: 
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Or from the Billing>Ready to Print view: 

 
 
You have the ability to email your permits from this view as well by putting a check 

next to each license to print and selecting Email Selected Documents: 

  
 

You will get an message if a facility’s email is invalid: 
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You can say ‘No’, and those with invalid emails will not clear from the view, so you 
can easily see which will need to be printed or have their email addresses updated 

before you can email their permit. 
 

For temporary restaurants that will be inspected in the field, the licenses can be 
printed in advance for the inspector to take to the event and hand out after 
conducting their field inspection or they can be printed in the field by the inspector 

at the end of the inspection. 
 

Cloning an Event 
If you have an event that happens every year, you will need to create it each year 

so there is a separate record in your database for reporting and tracking.  But there 
is an easy way to copy the information from the previous year. 

 
Click Clone Event and then rename with this year’s date, ex:  Fall Fair 2018 

 
 
Enter the start and end dates for the event, follow the prompts asking about the 

location and it will set up the new event. 
 

It will bring forward all vendors that attended the previous year.  If any are not 
attending, you can click Remove Facility and select the facility.  Or you can Add 
vendors using the Add Facility button: 
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Removing/Dissociating an Event and Vendor 
 

While the vendor facility and the temporary event have links to each other 
they are locked, and neither can be deleted.  

 
Open either the facility or the event and use the Remove button to clear 

these links. A facility must be in no events to be deleted; and an event must 

have no facilities in it before the event can be deleted. 

 
 

 
 

The inspections and/or permits must also be deleted before the facility can 
be deleted: 
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Operational Review 
 
There is not a function in HealthSpace to conduct the operational review for a 

seasonal/intermittent facility, but those documents can be scanned as a PDF and 
attached to the Temporary Vendor facility in the Comments section for the facility.  
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Billing Configuration 
 
Do not make any changes to any configurations settings other than those 
outlined here  

 

Billing Settings 
These settings are in Main Menu>Billing>Configuration>Billing Settings  
 

Several fields in the billing settings document establish parameters for the 
generation of annual licenses. This includes the manual licensing of new facilities 

and the auto generating the fees and renewal notices for yearly licenses and more. 

  
 
*Note: In the HealthSpace applications, it is the expiry date of the licenses that 

drive the annual renewal run, not the Start date. 
 

The Financial year end date field will need to be manually advanced to the end date 
of the upcoming fiscal year of the program area due for renewal.   
 

As an example: When facilities are expiring at the end of December 2019, and it is 
time to run the renewal applications, advance the end date to December 31, 2020: 

 
 
The Field Permit Renewal Number of Days is an editable field used to determine 
how far in advance of the current permit end date the fees and invoices should be 

run during an automated billing run. In our example, the Fees and Renewal notices 
will be auto generated 60 days in advance; around the 2nd of November.   
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Use Invoice Prefix. If there will be more than one person at the Health District who 
will be generating invoices, you will want to choose "Yes" to the field Use Invoice 

Prefix, as it is the prefix that will keep the invoice numbering unique from person to 
person. When this is set, when creating an invoice, the user will be asked to set 

their invoice prefix.  
 

Editing Fee Configuration Documents 
 

After the System settings have been entered, configurable fee documents need to 
be created in the database to define the fee amounts for each fee type for each 
facility module and type.  

 
This is done from the billing folder, under the Fees twistie, in the fee configuration 

view. 
 
Fee documents for Permit/License fees, Inspection Fees and Specific Fees must be 

created for all facility types and all modules before beginning to work with billing a 
facility. 
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New fee documents can be created from this view, by clicking on the button at the 
top of the view; “Create fee amount”. This opens a new document for setting up fee 

amounts: 

 
For each fee amount that is created, indicate if it is for an inspection, permit or 
specific fee amount. Choose which facility type it is for, facility type, and if 

applicable indicate the billing type.  
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Choose a fee amount, and if a late fee would pertain to this fee, use the 
check mark next to “Late fee”. A zero under Late Fee Lenience means that the 

late fee will be charged Jan 1 and every 30d after.  A 31 would start late fees on 
Feb 1. 

 
If you charge additional late fees, use a check mark in the applicable field. This 

opens fields to choose how many days after the current license expires should the 
late fee be applied. If the late fee will be a percentage of the original use the 
available radio button, and enter the percentage amount. If it is a specific amount, 

choose “Amount” and enter the value.  
 

Close the form with the OK button. If the Late fee repeats enter how many days 
after the late fee should another fee be generated, and how often another fee will 

be charged. 
 
Use the checkbox "Additional fee" for instances such as a Recreational Park or 

Campground if you have a set fee for a specific number of sites but charge an 
amount for each site over the set fee. For example: a health district might charge 

an amount for a campsite of 50-100 sites the amount of $500.00, and every site 
over this amount might be charged an additional amount of $5.00. When this is 
case, enter the number of sites on the campground facility document, and the 

system will auto-generate an amount based on that field. 
 

Exempt Fee documents: If a permit will be issued to a facility type, however this 
facility is exempt from having to pay a permit fee, set up the fee document as 
usual, however do not put a fee amount in, select the Exempt check box instead: 
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Permit fees are now available for fees created from the facility document for new 
facilities, or during a renewal run. 

 
After entering Inspection fees documents, the fee will be automatically generated 

when an Inspection of the correct type is saved in the system. 
 
Specific fees can be generated manually from the facility once these values have 

been entered into fee documents in the fee configuration view.  An example is a 
plan review fee. 
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Miscellaneous 
 

Replication and Save Conflicts 
Replication conflicts are caused in a few different ways, but they generally occur 
when two people work in/save the same document/facility at close to the same 

time.  When this happens, it will create a copy of that doc on the server to ensure 
that you have all your info.   Most of the time, the Replication or Save Conflict can 
be deleted after a quick review. 

 
They exist because the server has had several save hits on the same document—

this can happen from two people working on the same doc at the same time and is 
very common during the billing season because inspectors are inspecting the facility 
while the support staff are entering billing data into the document at the same 

time.  It can also happen if you have a document open for a long time and hit Save 
repeatedly.   

 
It is especially important to ensure the document you save has ALL your 
data before deleting the conflict during the heavy licensing period since 

the conflict may have fee payment information.  
 

 
They will show up in your database with a gray diamond: 

 
This can also happen if inspectors or office staff leave facility doc open a long time 
because the system will auto-save a copy periodically to ensure no data is lost. 

 
If you get a Replication error message, you can either say OK to create a separate 

facility or you can say no, that you don’t want to save the facility.  Then just close 
and cancel out of facility and it will not save the conflict.  If you say yes, then you 
can easily just look for the conflict doc and just delete it. 

 
When reviewing these Replication or Save Conflicts, you should: 

First open conflict doc (always do this first so you can tell which tab is the conflict 
 
Then open the original.  This will open as the second tab on your screen 

 
If the conflict document has good info, make changes on original and then delete 

the conflict document after updates are made and they are identical. 
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There is a tool for office staff to see a list of all conflicts: 
Main Menu>Administration>Reports&Tools>Conflict Report: 

    
 
Click the Update button at the top of the screen and it will show you the conflict 

and the original document and the differences between them: 

 
 
Then you can go to the Main Menu to final all the conflicts and delete them or make 

changes as necessary 
 

 

Pro-rating Licenses 
If you want to prorate your license fees after October 1st or if you have changed 
your fees for the next licensing year, you MUST Create Random Fee instead of 

Create Annual Fee to pay/generate a license. 
  
1) Enter new child facility or change of ownership like normal 
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2) In the Billing section, hit the Create Random fee and assign half the previous 
license fee: 

 
 

3) Enter a fee date of Dec 31, current year—this is CRITICAL: 
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4) Then enter half of the appropriate license fee if you are prorating or the 
regular fee if you are not.  It will auto-calculate for you as well if you enter the 

full fee amount in the bottom box and then 50 in the Percentage box and hit 
Calculate: 

 
 
5) Finally, enter a Description type of Annual Permit—also CRITICAL—do not 

add anything in front of this specific text: 

 
   
6) Then say OK and you will get a message.  Say Yes, and the license will be 

available to print:  
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7) Post payment to the license and then print like normal 
 

**For facilities with more than one fee, like Recreational Parks, you will need to 
enter each fee separately** 

 

 

Generating next year’s licenses for facilities that open 
after your renewals/billing run 
 
You have two choices here: 

a) This is automated so that once you post payment, it knows that the facility is 

ready for its 2018 permit fee.  It will generate the new fee overnight and 
generate the renewal. 

b) If you don’t want to wait, you can click on Create Annual Fee and it will 

create next year’s fee and Create Renewal so you can print it right from this 
screen (or from the ready to print view) 

Then you should then see both a 2017 license and a 2018 renewal for the facility: 

 
 

Choosing Between Second/Third/Final Renewals or 
Invoices 
 
**Note:  These are for payment reminders sent BEFORE late fees are 

assessed.  Once late fees begin after the first of the year, HS will auto-
generate renewals with late fees added for the facilities that are still 
owing.  These will be available in the Ready to Print View.** 

 
Because different counties have different preferences how they like to send out 

reminder notices, we have expanded the options you have available.  You now have 
two options for issuing additional notices of license revenue due:   

1) Second (or Third or Final) Notice correspondence document or; 

2) A total owing Invoice document 
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  Here are the pros and cons of each option and an example of each: 

Notice Type Pro Con 

Second Notice 

document 
 

Has clear header showing 

Second Notice with due 
date of 12/31/2019 

Can group by licensee for 

printing, but the process 
is more detailed 

Invoice document 

 

Easier to sort and print 
by licensee  
 

Shows up in the list of 
documents under 

Renewals and Invoices 

Has a randomly 
generated invoice 
number that will not 

match the original 
renewal number (can be 

an issue with corporate 
chains) 
 

Header shows ‘due upon 
receipt’ instead of date 

 

Second Notice Example: 
 

 

Invoice Example: 

 

 

 
The following pages will give you instructions on each option.  
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Creating Second/Third/Final Notices from the Totals 
Owing View 
 
Go to Main Menu>Billing>Totals Owing: 

 
 

Then click the + at the top of the screen to open all the facilities.   

 
 

If you don’t care about the printing order, then just select all by check marking 
them, hit the Create Correspondence (Batch) button on the top of the screen, and 
say Yes when it prompts you to add them to the Ready to Print view: 
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If you would like to print them so that those facilities with the same owner print 
together, then select any items that have the same owner with a check mark and 

hit the Create Correspondence (Batch) button: 

 
 
Repeat this for each grouping of facilities until you reach the bottom of the Totals 

Owing list.  Then go to the Ready to Print>Billing view: 

 
 
Put a check mark by the documents and send them to the printer.  The notices will 
print out keeping all the facilities with the same owner together. 

 
  



Page 81 of 94  Rev 12/19 
 

Then you can go back into the Totals Owing view and select all the single entries 
you haven’t created notices for yet and click Create Correspondence (Batch) to 

finish up the rest of the facilities: 

 
 
Finally, go to Ready to Print>Billing and print these and you are done!  
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Creating Invoices from the Totals Owing View 
 

Go to Main Menu>Billing>Totals Owing>By Facility Type: 

 
 
Click on the green plus at the top of the screen to ensure all twisties are open 

Click Create Invoices (All Outstanding): 
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Select All Outstanding Fees from dropdown that pops up: 

 
You will need to select All Outstanding Fees for each facility type, so don’t worry if it 

pops up multiple times.  It will also run through all the licenses to check them, so 
don’t worry if the count on the screen is higher than the number of facilities you 

have owing. 
 
When it is complete, it will then pop up an error report showing all the licenses that 

have already been paid which you can disregard and close that window: 
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To print by owner, sort by Licensee in the Ready to Print>Billing view, select just 
those facilities and print them.  Repeat this for each grouping by owner and then 

you can print all the remaining renewals as a big batch.  In this example, you would 
put a check next to the three that all have the same owner and then hit Print 

Selected Documents: 

 
Once you have printed all the facilities with the same owner, just go back and 
select all and hit the Print Selected Documents. 
 

And you are done! 

 

Exempt Status Facilities 
 
Use this status for School and General facilities to keep HS from trying to generate 

licenses for these facility types.  It is not for fee-exempt facilities like a soup 
kitchen, which should be a permitted restaurant. 
 

 
 



Page 85 of 94  Rev 12/19 
 

NSF Checks 
 
Payment was made (but it was not valid) and you want the history of what 

happened to show up, so you don’t want to just remove the payment. 
 
Payment was already made, so leave that payment there and leave the original 

permit in the system (do NOT delete it!) 
 

Hit Adjusting Entry button and add the total fee amount back 
 
Then hit Create Random Fee and add your NSF charge amount, in the description 

call it ‘NSF charge’ 
 

Here is what it will look like after all the adjustments have been made: 

 
 
If you need to, you can Create Invoice to send out to the operator.  Or if you had 
already mailed out their license, you can just apply payment and be done. 

 
 

Overpayments 
It is recommended that you choose not to accept the check and require operators 
to submit the correct amount 
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However, if you take the incorrect check, then enter the amount they paid into the 
system: 

 
You will get a message, say OK 

 
Then you should see the overpayment reflected in your Billing as Overpayment 

Details: 
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At this point, you can do nothing and allow it to be a credit for next year’s license, 
or you can document a refund by using the Adjusting Entry button: 

 
 

Then you have to hit ‘Post Payment’ to apply this amount to their invoice and return 
you to a zero balance: 

 
 

Batch License Payments 
Go to Billing>Totals Owing> to find a few different views to see your licenses and 

apply payments. 
 
You can sort any of these views by column and you can move the columns around 

as well. 
 

By Facility Type shows the facility and the amount due, so this is a good place to 
start: 
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Select the licenses you would like to apply payment to and then use the Post 
Payment (Selected Fee) button at the top to enter check details for each facility: 

 
 
**This will automatically add the licenses to the Ready to Print view so you 
can print them as a batch as well** 

 

Ready to Print View 
This is the best place to batch print renewals, invoices and licenses during the 
renewals period. 

 
Ready to Print view will automatically clear out records that have been printed.   

 
Note: Do NOT delete from this view, only use the De-Queue Selected 
Documents to remove from this view. 

 
If you have a printer error or something that causes a print error, you can go to 

Billing>Renewals and Invoices and hit Requeue for Printing to add them back to 
your Ready to Print view: 

 
 

If you send information to the printer and something happens at the printer end of 

things, then it will mark they were printed.  When this happens, you will need to re-
queue the renewals/licenses to get them back into the Ready to Print view. 

 
To do this, go to: 
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Recheck the facilities and then select the Requeue for Printing button: 

 
 

If there are items in the Ready to Print view you don’t want to see, then just select 
them and hit the De-Queue button to remove them from the view.  Do NOT delete 

them! 

 

Removing late fees from a license 
 

Before you apply payment to the license, open the child document, go to the 
Billing box and click the Remove Fee: 
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Then select all late fees that you would like to remove: 

 
And say OK.  Now apply payment and the permit will be generated and ready to 
print. 

 
NOTE:  Remove late fees, THEN pay the permit fees.  You need to do it in this 
order because the system considers the late fees to be part of the license fee, so 

they must be removed first. 
 

Also, if the late fees all generate on January 2nd and you wanted them to generate 
in February instead, you will need to go into the fee configuration docs and correct 
the number of days in the Late Fee Lenience field.  In the example below for a 

tourist facility, the 15 means that it will generate a late fee on January 15th.  
Otherwise, HealthSpace will see they are missing add them back for you overnight. 

 
NOTE:  Food facilities can assess late fees after the 1st of each month, but tourist 
facilities cannot assess the late fees until the 15th of the month because of 

differences in their statutes.  Keep that in mind when you enter the days in your fee 
configuration. 
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Emailing Inspections 
 
What happens when you email an inspection and it doesn’t seem to go 

when you get back and sync? 
Make sure that your Enabled box is Checked for Send Outgoing Mail: 

 
 

 
How to view emailed inspections sent from HS: 
This can only be accessed by a system administrator, so your main support staff or 

supervisor will have this role: 
Main Menu>Administration>Reports and Tools>Recent Emails Sent:

 
If emails do fail to send, you should get a message the following morning that they 
did not send and you can resolve them from there. 
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How to automatically send a copy of any emailed inspection to the 
inspector responsible for the facility: 

Those with ‘Assigned Inspector’ can enter an email of choice in that office/staff 
document for the messages to be sent to.  Or you may want to create a generic 

email for your office, so all the inspections are sent to a single location. 
You can also turn on this feature yourself in System Settings if you have an 
administrative role (do NOT make any other changes to this screen!): 

a) System settings>Inspection Settings>Emailing options   
b) Change the information in Email Inspection (Reply To) box from None to 

Inspector  
c) Save and you are done! 

 

Which email addresses are used for which parts of the software? 
• Inspections—HS uses Phone/Email tab on the facility document 

• Billing/Invoices/Permits—HS uses owner info Phone/Email   
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Best places to enter information in the system 
 
What are the best places to enter info in one place owner/facility/address) so it will 

properly reflect throughout the facility?  And which fields do what throughout the 
program? 

 
New Parent/location document: 

1. You must enter site address for location 

 
But you do not need to enter Building contact information---not really used 
 

2. Then add Licensee/Owner information 
a. New button: 

 
b. It will prompt you to enter licensee details, say Yes 

 
c. This owner info is what is used for the billing, so it is very 

important 
d. Enter Primary Contact Last and First and address under contact and 

Mailing Address tab=main owner’s address.  Do not fill in Primary 

Contact first and last if it is the same information as the 
licensee otherwise it will show up twice on the license. 
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PO Boxes are special.  Enter Type first and then it will let you put in a PO Box 
number: 

 
Only fill in alternate mailing if they want their billing to go to a different address.  
You don’t need to fill out this box otherwise.  The critical tab is Contact & 

Mailing Address. 
 
You can enter Owner email/phone as well.  This email will be used for billing 

emails (renewals/licenses). 
 

Child/facility document: 
Billing should default to Owner Address to mimic how it was set up historically in 
Phoenix 

 
Choose which address to copy for mailing (Physical address or Business/Owner 

address) 
We recommend using Business address for consistency: 

 
 
Facility email address entered here will tie to correspondence and 
inspections: 

 


